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Overview

Tegrity is a flexible software tool that can capture audio, video and
computer screen activity, then wrap it up in a single “Tegrity session”
which can be automatically uploaded and linked into your Blackboard
course. Tegrity can be used from Tegrity enabled classrooms or from
office/home/studio computers to create lessons, provide
communication, and develop materials for a variety of uses.

Advantages and Disadvantages
Advantages

o Ease of use.
o Tegrity sessions are available anytime online.

o Tegrity can used to create online lessons in your office or at
home.

« Adding media to online courses is a good practice.

e Tegrity sessions can be automatically uploaded to
Blackboard.

Challenges

e Tegrity is a Windows-only program for both authoring and
viewing, though Macintosh users can listen to the audio
podcast of any session.

« Editing of Tegrity sessions is limited, so they often have the
“live” feel of the moment you created them.



Chapter 1: Recording With Tegrity Campus 2.0

Thank you for using Tegrity® Campus 2.0, an industry-leading solution for both instructors and students.
With Tegrity Campus, you can create engaging and effective multimedia content that can be archived and
viewed on demand at any time, from anywhere. Tegrity Campus is flexible, powerful, and easy to use.

In This Chapter:

» Capturing Your Class With Tegrity Recorder
» Reviewing Your Recorded Class

» Accessing and Managing Recordings You Have Uploaded

Capturing Your Class With Tegrity Recorder

Tip:  Even though your PC may have a built-in microphone, it is recommended that you attach an
external one or use a wireless microphone. The audio recording quality improves with a good
external plug-in or wireless microphone.

1. To launch Tegrity Recorder, use one of these two options: Tegrity icon

e Double-click the Tegrity icon in the system tray (at the
bottom right side of your screen).

"‘&_,Jr Ty, M o11:12 am

Note: If the Tegrity Web Service has never been launched
from this computer, you won’t see a Tegrity icon in
your system tray. To record your first class you must . Your Institution
launch the Internet service through your institution’s e UNIVERSITY
course management system (CMS), with a direct link
you receive from your IT department, or from a Web
link located on another portal.

Record a Class

e Accessed from the Internet, the Tegrity Campus course management page appears with the Record a
Class button in the upper left-hand corner. To launch Tegrity Recorder, click Record a Class.



Capturing Your Class With Tegrity Recorder

The Tegrity Recorder dialog box appears.

T Tegrity Recorder

Your name appears here. __|

Hello, Second Instructor (dick ta change)

Note: If the name that appears is not
yours, click the name to change it.

Course; |Microhiology Il ~|

Recording Title: |FriJul14, 1027 AM

Select Picture _ TestAudio | | Seftings | | Tutarial
| Recommended
Audio Level
i Record a Class W TEGRITY
2. From the drop-down list, select the course name for this class session.
Courses identified with you in your institution’s Course: |Please. selectacourse.. |

course management system (CMS) appear
automatically in the drop-down list.

Flease, select a course...
bicrobiology Il

Support Cases

Fecord for a not listed course. .

Note: Ifyour institution has a course management system (CMS), specific courses names should appear in the

drop-down list. If you do not find such a list, or if your course title does not appear, contact the IT group
in your department or institution. Also see Chapter 4, “Troubleshooting,” beginning on page 35.

3. In the Recording Title field, type a title you prefer.

It is recommended that you type a meaningful title of your own choosing. A good title helps students locate
the correct recording. You can add to the date and time information provided or replace it entirely.

e Retaining the date/time information—Chemistry 403, Thurs. Feb 18, 2:05 PM
e Replacing the date/time information—Chemistry 403, Comparing Solvents

Important: Titles you type cannot contain the following characters: \/: * ? % ” <> | & ;’
You may include commas, hyphens, and periods as appropriate in your titles.

2 » Tegrity Campus 2.0 Instructor Guide



Capturing Your Class With Tegrity Recorder

4. To verify that the microphone is ready for recording, speak aloud—in a normal speaking voice—and note the
activity of the volume scale. NOTE! Some USB mics used at YC don't show level, but do work!

' Your speaking voice should register

To raise or lower the__@ Recom mended in the green-to-yellow area of the
recorded volume, . scale.
move the volume . You want to record in the green (or yellow)
control up or down. Audio Level register. Recorded in the red, your voice may
sound distorted when played back

Tip: Ifyou have students taking notes with a standard pen or pencil (not using Tegrity Notes), you may
want to turn on the minute counter (available in Settings). When you do, the counter appears on
screen, showing the time that has lapsed during the recording session. For details, see “Showing the
Minute Counter on Your Screen” on page 9.

5. Click the Record a Class button.

6. Read the information in the dialog box that appears and click OK.

Note: If you prefer not to have this dialog box appear before every recording session, click to select the
check box beside “Don’t show this message again.”

After you click OK, the dialog box closes, and the screen goes dark for a moment.

7. Wait for three recording control icons to appear in the Stop
system tray. Pause —

e Pause— Lets you take a break in the recording, as i I i . | E
needed. Click to pause; click again to resume.

e Stop—Ends the recording session.

Recording Volume

e Recording Volume Indicator—Indicates the audio level that is being recorded.

8. Begin speaking—you are being recorded.

Conduct your class as usual. You can launch and use almost any Windows-based application for your
purpose. For example, you can use PowerPoint, Adobe Acrobat Reader, Excel, and Internet Explorer—and
others. Your interactions with these applications are recorded along with your lecture.

9. As you record, you may use the annotation toolbar to enhance and enliven your presentation.
To use the annotation tools, click to expand the To expand the
Tegrity icons portion of the system tray. It floatson  toolbar, click here.i il R l | E]
top of the other screen content. Your annotations
appear as part of the screen content.

For an explanation of the tools in the toolbar, see p YAERN I l|E]

“Using the Annotation Toolbar” on page 5.

Tegrity Campus 2.0 Instructor Guide ¢ 3



Capturing Your Class With Tegrity Recorder

10. When you have finished recording your lecture, click the Stop icon on the system tray.

A Tegrity Recorder dialog box asks you to confirm that you want to end the recording.
In classrooms, select Upload Later and Yes. In your office or studio, Previewing
prior to upload may be preferred.

Sends the recorded lecture to temporary
storage on your PC, to wait for a

pre-scheduled upload to the Tegrity server._|

Lets you preview your recording,
after which you can choose to Upload Later,

Upload Now, or Delete the recording. |

Processes and sends your recording _|

to the server now.

T Tegrity Recorder,

—|_[()o you want to end the recording?
* Upload later (recommended)
— Preview now

— Upload now

Erases the recording._| [ Delete

After you select the action you want, click Yes.__|

To cancel and resume recording, click No.

11

‘Yes I No

X

11. Select Upload Later, and click Yes.

For Tegrity Recorder to process and upload your class session, please make sure that your computer
is powered on and online between midnight and 8 a.m. If you decide not to wait until “later,”

right-click the Tegrity logo icon in the system tray, and then select Upload Recordings Now from the

pop-up list.

Tip:  PowerPoint provides a group of animation effects called Entrance. These animations introduce new
elements into a slide when you trigger Next in slide-show mode. Entrance animations are available

from the PowerPoint Slide Show menu:

> Custom Animation > Add Effect > Entrance.

For details about using the Custom Animation panel, see the documentation that came with
PowerPoint. Feel free to use Entrance animations, but avoid any other types of PowerPoint

animations. If you use animations other than Entrance, your view of the slides is not synchronized

with the students’ view. The non-Entrance animations can look fine during recording, but during

playback they do not work properly.

4 » Tegrity Campus 2.0 Instructor Guide



Capturing Your Class With Tegrity Recorder

Using the Annotation Toolbar

Note: Although the annotation toolbar is available on any computer, creating annotations while you are
recording is easier with a Tablet PC or a Wacom tablet.

1. Click the expand arrow near the Tegrity icons in
the system trayr. Expand arrow «B I1 B l | E]

2. To use the annotation pen, highlighter, colors,
B o]

and drawing tools, click the pencil icon.
When you click the pencil, the toolbar expands again, displaying additional choices:

Pencil

Pen Colors and Highlighter (yellow) Select Object

Pen Line Widths Erase Object

Draw tool Erase All

Draw Tools Expanded Pen Colors Expanded

000 / EEEE |

=8 P ¢ e CEY N

Pen Line Widths Expanded

(=== ]

CErEET %
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Capturing Your Class With Tegrity Recorder

3. To insert a new page/slide into your presentation, click the page icon.

Do

Insert Page

When you click the page icon, the toolbar expands, displaying additional choices:

For the new page/slide you insert, If you change your mind about
you can choose one of three inserting a new page, click the
templates: grid, lines, or blank. X to cancel insertion.

- SIS

If you do insert a page, the next time you click the page icon, your most recent insertion appears as a fourth
page template. This makes it possible for you to go back to the last page you inserted and modify its content.

The last page you inserted (with your annotations)
is included among the page template options.

< SN [T

Note: While you use the annotation toolbar during a recording session, it appears on screen the whole time.
During playback, the toolbar is also visible—except when PowerPoint is in slide-show mode.

6 ¢ Tegrity Campus 2.0 Instructor Guide



Capturing Your Class With Tegrity Recorder

Using the Toolbar When It’'s Expanded for Video

If you have a video camera attached to your PC (intending to capture live video during your class presentation),
Tegrity Campus adds a camera icon to the annotation toolbar.

Video camera icon

n AN 0 |T] %7719 C 2, asaem

When you click the camera icon in the annotation toolbar, a thumbnail version of the live video appears.

Tip:  You can drag the thumbnail video to suitable places on your PC screen.

In addition to an instructor video camera connected to your PC, you can show your students video from other
sources. For example, you might have the instructor camera, a document camera, and a DVD or VCR connected
to your PC. When you have multiple video sources, and you click the camera icon in the annotation toolbar, you
see a thumbnail for each video source.

Two video sources,
each with its own
thumbnail image

xJ

et Explorer i . IEI.E? G e I|E

Tegrity Campus 2.0 Instructor Guide 7



Capturing Your Class With Tegrity Recorder

m  To expand a video to full size on your screen, click its thumbnail image.

U4 start wé | (@ ATGT Yahoo! Messen... | [B] 5 Micosoft Office 0... ~| 7 6 Internet Explorer B B oD m & )77 1127

When you click a thumbnail image to expand it to full
size, the camera icon changes to a monitor.

bnﬁm neflG

m  To return to the thumbnail-size video image, click the monitor icon. The full-size image reverts to a
thumbnail, and the monitor icon changes back to a camera).

m  To dismiss the thumbnail video, click the close box (the X) beside the thumbnail image.

Close box

et Explorer - - i1 B l|E]
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When You Do and Do Not See Video Camera
Recordings

e VIDEO CONTENT - The video cameara doesn’t always record.
Tegrity records your camera video only under these 3 conditions:

1. You are in a PowerPoint Slide
Show.

oD n el

2. You are using annotations.

3. You select the video camera icon from the annotations toolbar

EIDQE: ] ll_ﬁl

Seeing this icon (“monitor”) indicates you are recording with
the video camera.

8a



Capturing Your Class With Tegrity Recorder

Showing the Minute Counter on Your Screen

The minute counter displays on screen the current minute during recording. The counter begins at 00 (two
zeroes, in red) and advances the minutes as the session progresses. This benefits students taking notes with a
standard pen or pencil. They can write down the times of specific points in your presentation. Later, they can use
these written cues to coordinate their notes with a review of the recorded session.

Note: Students using a Tegrity Pen with Tegrity Notes do not need the minute counter. The notes they take are
automatically time-stamped to synchronize with the recorded session.

<> To turn on the minute counter, you need the Tegrity Recorder dialog box on your screen

1. Click the Settings button.

T’ Tegrity Recorder

Hello, Second Instructor (click ta change)

Course: |Microbiology I ~]

Recording Title: |FriJul 14,10 27 AM
Click Settings.

Select Picture TestAudio || Settings | | Tutarial

| Recommended
Audio Level

' Record a Class W TEGRITY

Tegrity Campus 2.0 Instructor Guide ¢ 9



Capturing Your Class With Tegrity Recorder

2. In the Tegrity Recorder settings dialog box, click the check box for “Show minute counter.”

T | Tegrity Recorder

Select Instructor Video: _

1 | Test Audio |

Click to select
“Show minute counter.”

Show minute counter ﬁlf'

Automatically create and upload daily at: |'|2:DDP«M 'i

Choose audio source:

!Microphone v|

i Save and Close l Cancel |

3. Click Save and Close.
4. In the Tegrity Recorder dialog box, click Record a Class.

5. Wait for three recording control icons to appear

Stop Recording Volume
in the system tray. Pause —| r 9

Do i)

The 2-digit minute counter appears on your screen for the duration of the recording.

6. Begin speaking—you are being recorded.

o
7. To move the counter to another area of your screen, simply click and drag the red numbers. J U

Note: The minute counter is visible on screen only during a recording session. The numbers are not recorded
and do not appear during the playback of a session.

10 « Tegrity Campus 2.0 Instructor Guide



Reviewing Your Recorded Class

Reviewing Your Recorded Class

You can review your recording as soon as it has been uploaded and processed and is available online.
1. Log onto the Internet and connect to your institution’s course management system (CMS).
2. Click the Tegrity link on the CMS home page.

3. In the Tegrity Campus class list page that appears, find the class you want to review and click the Play button
beside the class title.

‘A Tegrity Viewer - Microsoft Internet Explorer ‘Z.HE"

‘ﬁ%i b Your Institurion

UNIVERSITY

Record a Class Tutoial  Help

My Courses = Microbiology II Search
[ B + | course Management Mon,Aug 14, 03 04 PM 8/14/2006 | 08:18 QY
CI|Ck the Play button 1 B + | syllabus and Overview of Class 8/9/2006 02:12 ay
beside the tlt'e Of 4| + | Pre-Lab Safety Procedures 8/4/2006 06:44 QY
the ClaSS you Want [1 B + | crading and Attendance Palicy 8/1/2006 00:39 ay
to review I B + | Pre-Lab Chloroplasts 8/1/2006 11:13 ay
[0 B + | Electron Microscope-How to Use 7/27/2006 | 05:24 QY

On the Te grity Player 7 Tegrity Viewer - Microsoft Internet Explorer

screen, the recorded -
UNIVERSITY

lesson plays back.

My Courses > Support Cases > Image for documentation plaver

E 4

Show the

Chapters |_Search

: — — ]
k [wa][ 00 |[me]o0 ____Jetlf=""7) [&](¥][00][? | @ TEGRITY

Playing

Tegrity Campus 2.0 Instructor Guide * 11



Reviewing Your Recorded Class

4. Use the control panel (at the bottom of the player window) to accommodate your preferences as you watch the

playback.

Shows your Print all chapters

progress
through the

recording. — - | SrERRRNEAN Crasters | Swatch | -
L

Previous -y ﬁl e | 0:00:20 e CJl| é Bill= | ? | @ TEGRITY

Chapter z wing, A | .. | A "-_l_H' .

Tells you that a LNext Chapter |_Volume

presentation is Downloads the recording
paused or playing Pause/Play

to your local hard drive

e To see an index of the different slides in your presentation, click Chapters.

Slides in Chapters view.

(1] 0:BE: BD - B 00: 2

¢
ir Y MJ‘..;.J -
: B DAYSL
r [2) B:00: 26 - 0:00: 51

BRI
& renews 196..,

As you mouse over each slide,
it enlarges for easier viewing.

(4] 00420 - 0:01:11
Whitehoard

To jump to a particular
chapter, hover over it to
enlarge it, and then click it.

Presentstion | Chapters | Search |

| — !
(= [ [oe)ooom (el (&) (][0 [ 7 @ TEGRITY
Paused

e To jump to another chapter in the presentation, enlarge it and click it in the Chapters view. The
presentation begins playing again at that slide. You can use Chapters index to go forward or backward in
the presentation.

5. When you finish reviewing the recording, use the
breadcrumbs to go back to the course management page.

My Courses = Microbiolo

II = Quiz Review
You can review other classes in this course. If you want

to review classes in a different course, you can use the
breadcrumbs to go to the My Courses page and select from there another course name.

12 « Tegrity Campus 2.0 Instructor Guide



Accessing and Managing Recordings You Have Uploaded

Accessing and Managing Recordings You Have Uploaded

To work with recordings you have uploaded to the Tegrity server, go to your course management page.

Your Institution
UNIVERSITY

Record a Class Tutorial  Help

My Courses = Microbiclogy 11 l:l Search

[J B =+ | Course Management Mon,Aug 14, 03 04 PM 8/14/2006 | 08:18

[0 = =+ | Syllabus and Qverview of Class 8/9/2008 02:12

[0 B + | Pre-Lab Safety Procedures 8/4/2006 06:44

K K &« «

[J B + | Grading and Attendance Policy §/1/2006 00:39

[] B 4 | Pre-Lab Chloroplasts 8/1/2008 11:13

[ B = | Electron Microscope-How to Use 7/27/2006 | 05:24

O @ 4 | Organelles Preview 7/15/2006 02:12

[ = = | Microbiology Wednesday Lecture Series 1 7/12/2006 79:28

® |«

[ B =+ | office Hours and Procedures 7/6/2006 09:36

[ B + | Quiz Overview Friday July 7th 7/6/2008 21:03

66AAAAAAAALE
« | |«

« |«

1 B + | cellular wall Structure 7/6/2008 03:45

‘ Legend: Mot Bublished Being Processed [BMiNGICOBRING Faile.di

W TEGRITY

i4 start wé | % Windows Messen... B search Results 5Micosoft Offi.. = 7 4InternetExplo... -| [ MicosoftPower?... 7" & B % L] 1:59Pm

Reports | | Settings | |EETE_{°\C_U?I75 | |iPod| [Mp3 | [RSS | <« B pagei 23 4 of 4 pages (38 recordings)

Using this course management page, you can perform most of the tasks related to managing your recordings
after they have been uploaded.

Search for key words in all the recordings shown

Review the title, recording date, and duration of each class in the list

Play a recording for review

Scan the chapters in a recording

Download a recording to your PC for easy access when you are unable to connect to the Internet
Study reports of student usage

Evaluate and modify your master settings for Tegrity Campus 2

Rename, delete, edit, copy, move, and publish your recordings

Navigate easily through the recordings listed for your course

Navigate among your courses when you have more than one

Tegrity Campus 2.0 Instructor Guide » 13



Linking sessions in Blackboard manually

You can link Tegrity sessions anywhere in Blackboard.

1. Go to http://europa.yc.edul/teqrity .

2. Find the folder with your YC user name, and double-click it.

3. You should then see a listing of folders named by classes which
you have uploaded recording to. Click the class folder that contains
the session you want.

4. You should then see a listing of uploaded sessions. Right click on
the session you want to link to, and select “copy shortcut”.

5. Log in to Blackboard

6. Go the “add a new external link item” in any content area of your
Blackboard course, and paste the copied shortcut in to the “URL”
field to create the link.

Email the session link to your students
Follow steps 1-4 above, then paste the link into an email message.

13a



Accessing and Managing Recordings You Have Uploaded

Searching Through Your Recordings

In the Search field, type a key word or phrase and click the Search button.

R e

|TE.'!i1ritj,-' | Search |
=

Tegrity Campus goes through all the recordings and presents the results on a separate page (or pages).

To backtrack to the
course management
page, click the course
name shown here.

This path information is often
referred to as breadcrumbs.

Your Institution
UNIVERSITY

Record a Class Tutorial  Halp

| My Courses = Microhiology 11 = Search Search

rnzit rernrdinn? m<i?g

Index - http:/fathena2.tegrityonline.com - Tegrity Viewer - Microsoft Internet...

rnzit rernrdinn? m<i?&
n:25

N
Index - http://athena2.tegrityonline.com - Tegrity Viewer - Microsoft Internet... |

Wed Tnl NS N2 N1 PM

ni: 2R
1 Index - http://athena2.tegrityon|ine.®om - Tegrity Viewer - Microsoft Internet...

| Cellular Wall Structura
n>-4?

Index - Tegrity Campus 2.0 - Microsoft|Internet Explorer

| <@l P> roge 2 o4 5 of 22 pages (96 results) E TEGRITY
To go directly to a specific item found in the__| Another way to go to the _|
search, click its address here. (As you mouse source is to click the
over it, the address changes color.) chapter it comes from.

14 « Tegrity Campus 2.0 Instructor Guide



Accessing and Managing Recordings You Have Uploaded

Reviewing Class-Specific Information

For each recording listed, the course management page provides class-specific information that helps you
identify any class you want to select from the list.

Class Column

The title listed for each class is the same as the Recording Title you entered in the Tegrity Recorder dialog box.
(For details, see step 3 on page 2.)

Each recording for a given course should have a distinctive title that may or may not include the date on which
the class was recorded.

Recorded Column

This tells you the date on which this class was recorded.

Duration Column

This tells you how long the recording lasts (in minutes and seconds).

‘our Instirution

UNIVERSITY

Record a Class Tutorial  Help
My Courses = Microbiology II l:l Search
Column heads Ty T T
[0 # =+ | Course Management Mon,Aug 14, 03 04 PM 8/14/2006 |08:18 QY
[ B =+ | Syllabus and Overview of Class 8/9/2006 02:12 ay
[0 B + | pre-Lab Safety Procedures 8/4/2006 06:44 ay
[0 B =+ | Grading and Attendance Policy 8/1/2006 00:39 ay
O B + | Pre-Lab Chloroplasts 8/1/2006 11:13 ay

Tegrity Campus 2.0 Instructor Guide * 15



Accessing and Managing Recordings You Have Uploaded

Playing a Recording from the Course Management Page

Reviewing your recordings once they have been uploaded is quite easy.

<> Click the Play button beside the name of the recording.

To view a recording
that you'’ve uploaded,
click the Play button
____ beside the
P> | classtitle.

To start viewing from a
point within the
recording, click the
chapters (+) icon.

For details, see
“Reviewing a
Recording Chapter by
Chapter” on page 17

our Institution
UNIVERSITY

Record a Class Tutorial  Help

My Courses = Microbiology 11

O b + | course Management Mon,Aug 14, 03 04 PM 8/14/2006 | 08:18 ay
OO W + | syllabus and Overview of Class 8/9/2006 02:12 ay
| L = | Pre-Lab Safety Procedures 8/4/2006 06:44 ay
[ @ 4+ | Grading and Attendance Policy 8/1/2006 00:39 QY
1 B + | Pre-Lab Chloroplasts 8/1/2006 11:13 ay
O P + | Electron Microscope-How to Use 7/27/2006 | 05:24 ay
O P + | organelles Preview 7/15/2006 | 02:12 ay
[1 = + | Microbiclogy Wednesday Lecture Series 1 7/12/2006 | 79:28 ay
(R _J 'Il' Office Hours and Procedures 7/6/2006 09:36 aY
O B 4+ | Quiz Overview Friday July 7th 7/6/2006 21:03 QY
O p> + | cellular wall Structure 7/6/2006 03:45 ay

Legend: not Published Seing Frocessed BVINGIEEBWING Fail=d|

Reports

Settings | | More Actions ~| iPod | |Mp3 | |RSS

W TEGRITY

- Pagel 2 3 4 of 4 pages (38 recardings)
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Accessing and Managing Recordings You Have Uploaded

Reviewing a Recording Chapter by Chapter

If you would rather select chapters to review, click the plus sign beside the title of the recording.

Y &% Your Institurion
'ﬁ%’ UNIVERSITY

Record a Class Tutorial  Help

Search

. My Courses = Microbiology II
For a chapter view, 3

click the pluS Sign, [ B~ + | Course Management Mon,Aug 14, 03 04 PM 8/14/2006 | 08:13 ay
(N 2 'Il' Syllabus and Overview of Class 8/9/2006 02:12 ay
[ B + | Pre-Lab Safety Procedures 8/4/2006 06:44 ay
[ B + | Grading and Attendance Palicy 8/1/2006 00:39 ay

The screen that appears displays the first slide of each chapter. Chapters are numbered, and a descriptive caption
appears under some slides.

3 Tegrity Viewer - Microsoft Internet Explorer
F [ Your Institution l
R T | Logo Here %

Record a Class Tutorial  Help

My Courses = Microbiology II = Embrions | H Search |

S

5 Blastocyctes-Blastoc...

[remam 05t (54
[-.-.-m-n:.

1 Microbiclogy Dr. Ber... 2 Hemoglobin 3 Hemoglabin

7 Embrions 8 Embrions 9 Embrions 10 Surveys - ...

11 Surveys - . 12 Whiteboard 13 Autormated Message 14 Autormated Message

Ly
Page 1 of 1 pages (14 chapters) E TEG RITY

To start playing the recording at the beginning of a particular chapter, let your mouse hover over the chapter to
enlarge it. Then click the chapter image once.
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Accessing and Managing Recordings You Have Uploaded

Downloading a Recording to Your Local Hard Disk

There may be times when you won’t have access to the Internet. If that’s the case, you can plan ahead and
download to your laptop PC any recording you need.

<> Click the download button beside the name of the recording. [gji Download button

Your Institution

UNIVERSITY

Record a Class Tutorial  Help

To put a copy of a

recordlng on your My Courses = Microbiology IT l:l Search
hard disk, click the
download button. [J B + | Course Management Mon,Aug 14, 03 04 PM 8/14/2006 |08:18 ay
[J B =+ | syllabus and Overview of Class 8/9/2008 02:12 a I¥
[J B =+ | Pre-Lab Safety Procedures 8/4/2006 06:44 ay
[0 B + | Grading and Attendance Policy 8/1/2006 00:39 ay
I B + | Pre-Lab chloroplasts 8/1/2006 11:13 ay
[0 = + | Electron Microscope-How to Use 7/27/2006 05:24 ay
[ b + | Organelles Preview 7/15/2006 | 02:12 QY
[] B + | Microbiology Wednesday Lecture Series 1 7/12/2006 | 79:28 ay
[ B + | office Hours and Procedures 7/6/2006 09:36 ay
[ # + | Quiz Overview Friday July 7th 7/6/2006 21:03 ay
O b= + | cellular wall Structure 7/6/2006 03:45 QY
[ Legend: Net Published Being Processed HGUNGIGBEENG Failed|
_- Reports ‘. SE“”_‘QE- Wl ;V'P”d” ,Mpa; RSS_: P> pagei 2 3 4 of 4 pages (38 recordings) E TEGRITY

‘4 Start wd | % WindowsMessen... | B SearchResults [El 5 Miqosoft Offi.. - 7 4 IntemetExplo... +| B3 MicosoftPower... 77 & 1771 1:59pM
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Accessing and Managing Recordings You Have Uploaded

Viewing Reports on Student Usage Rates

< To see reports on viewership for this course, click the Reports button (at the
bottom of the screen). Reports

The report that appears provides information about each recording for a specific course

Your Institution
UNIVERSITY

Record a Class Tutorial  Help

My Courses = Report{ Dates: 9/1/2006-9/30/2006 ) Select Dates Al Last Week Last Month

Accessing Tegrity Recording in Blackboard Users| 00:01:40
Blastocytes Users| 00:00:03
Electron Microscope-How to Use Users| 00:19:16
Grading and Attendance Policy Users| 00;00; 18
MNew MName Users| 00:00: 32
Office Hours and Procedures Users| 00:10:31
Pre-Lab Chloroplasts Users| 00;01;27
Pre-Lab Safety Procedures Users| 00;00;15
Pratozoa Users| 00:08:08
Quiz Review Users| 00:33:25
Quiz Review Part 2 Users| 00:06:48
rozit recording msi2s Users| 00;00; 18
Syllabus and Overview of Class Users| 00:00: 40
Taking uncontaminated samples Users| 00:03:16
Test to see when or if this uploads Users| 00:01:42
Wed,Sep 13, 10 42 AM Users| 00:03:10
Total - 01:31:29

ARG R EEEEE

<> To see each student’s name, viewing duration, and number of times he or she viewed a recording,
click the Users link.
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Accessing and Managing Recordings You Have Uploaded

Reviewing Your Settings for Tegrity Campus 2.0

Certain settings for Tegrity Campus 2.0 are predefined. To see what they are, and to modify _
settings as needed, click the Settings button at the bottom of the screen. Settings

Your Institution
b UNIVERSITY

Record a Class Tutorial  Help

My Courses = Microbiology 11 Settings

Publishing: dutomatically publish classes after upload

Delivery: allow students to download classes
O enable Macintosh support
Enable MP3 podcasting
Enable iPod/iTunes (enhanced podcasting)
Enable RSS support
Enable mohbile phone support

URL: Displayed Text:
|ht1p fhanern tegrity. com |Tegrity website

[ allow students search on class audio (significant increase of processing time)

Apply changes to all previously recorded classes now

TEGRITY

Explanations of the settings appear in the sections that follow:

Publishing

m  To publish your recordings as soon as you upload Automatically publish classes after upload

them, leave the option selected (the default
setting). When a recording is published, it is visible to your students and available for review. If you prefer to
publish each recording manually, click to remove the check mark. Students can view your class recordings
only when you choose to make them available.
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Accessing and Managing Recordings You Have Uploaded

Delivery
m  When checked (default), students can download Allow students to download classes
classes to a local hard drive. L1 Enable Macintosh support
s When checked (unchecked is the default), Enable MP3 podcasting
supports Macintosh users. Enable iPod/iTunes (enhanced podcasting)
m  When checked (default), supports MP3, iPod/ Enable RSS ;
iTunes, and RSS subscribers. nabie =Hppar
Enable mobile phone support
Note: If you remove any of the check marks (deselecting the feature), v
the associated buttons are also removed from your course iPod| | Mp3||RSS
management page and from the equivalent student page. ‘
Canceling the feature is not retroactive, however. Students may
continue to play podcasts they acquired when subscriptions were allowed.
Links
LIRL: Displayed Text:
m  When checked, you can |ht1 o tearit | |_|_ " bit |
type a URL and the text po iy Tegrity. com egrity website
displayed to represent | | | |
the URL on the Tegrity | | | |
player screen. You can
type up to four different | | | |
URLs and text labels.
Misc.
= When checked L] allow students search on class audio {=significant increase of processing time)

(unchecked is
the default),
the Tegrity

Aoply changes to alf previously recarded classas now

software creates a text transcript of the audio portion of the recording. The text is then available for key-word
searches. The process takes a long time to complete and creates very large files. These files, when created,
have nothing to do with closed captioning for viewers.

Restore Defaults

To restore all the settings to what they were when you initially launched

Restore Defaults

Tegrity Campus 2.0 (often called factory defaults), click this button. To see the restored default settings,
refresh the page (F5) or navigate away and return to the Settings page.
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Accessing and Managing Recordings You Have Uploaded

Applying More Actions to Recordings

The More Actions menu contains actions you can apply to selected recordings in a course.

(] + | sccessing REERRSIUERN G in Blackboard
FRename
Delete
Edit
Copy
Mave
Fuhlish

Feports Settings | | More Actions | | IPod | | Mp3 | | RSS5

Choosing commands from the More Actions menu, you can rename, delete, edit, copy, move, or publish
selected recordings.

Note: Before you can choose a command from the More Actions menu, you must click the check box to select
the recording that is subject to the command.

Rename

1. Click the check box to select the
title of the recording you want to | Rename session : Sat,Sep 16, 11 43 AM = |

rename.

2. Choose Rename from the More
Actions menu.

3. In the window that appears, type
a new title for the recording and
click OK.

Please,enter new title here

4. The recording’s title is updated. | [

Ok
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Accessing and Managing Recordings You Have Uploaded

Delete

1. Click the check box to select the title of the recording you want to delete.

2. Choose Delete from the More Actions menu.

Microsoft Internet Explorer

3. In the dialog box that appears, click OK to confirm that you 9| Youhave asked to delete the Follwing classes:
want to delete the recording. & Tuesen 15, 04 22

Do wou wish bo continue?

[ o | [ Cancel

Edit

You can perform a simple edit that involves cutting out parts of the recording that fall between times you
specify.

1. Click the check box to select the recording you want to edit.

2. Choose Edit from the More Actions
menu. 01 FM From: | | | [Te:] | cut

The recording begins to play back,
and the buttons From and To
appear in the upper-right of the
player screen.

Correct Use of Syringes

*(Wear rubber gloves g |_ Q\
. i 1 ( -h 7 =
3. When you want the cut to begin, Wipe the intended area U
click the From button. with iodine .

4. When you want the cut section to end, click the To button.

5. Then click Cut.
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Accessing and Managing Recordings You Have Uploaded

Copy

You can copy a recording from one course to another. This is convenient when the same class presentation
applies to two different courses.

1. Click the check box to select the recording you want to copy.

2. Choose Copy from the More
Actions menu.

3. In the dialog box that appears,
locate the course to which you
want to copy the recording.

4. Click OK.

Move

Move and Copy are similar, but Move takes the recording away from one course and adds it to the class list of
another course,

1. Click the check box to select the recording you want to move.

2. Choose Move from the More
Actions menu | Moving: Test to see when or if this uploads = |

3. In the dialog box that appears,
locate the course to which you part of 1t 1o norrow the search, -
want to move the recording.

Instructar:
You can type a part of the course
i to narrow the search
4, Click OK. nare, .
C c 0 Course: Tip: Leave the instructor name
‘ ‘ [ Search ] empty, if you want to search all
the courses.

Ok Cancel
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Accessing and Managing Recordings You Have Uploaded

Publish

Most of the time your recordings are published as soon as they are uploaded. This is controlled by one of the
features on the Settings page. For details, see “Reviewing Your Settings for Tegrity Campus 2.0” on page 20.

If you deactivate the setting for automatically publishing all uploaded recordings, you must take the time to
publish each recording manually. This option lets you customize the Publish feature. For example, you can
make recordings visible to students on a specific date, remaining visible only until another date you specify.
This affects only the student view. The recordings are always visible to you as the instructor. In your course
management page, unpublished recordings appear highlighted in yellow until you publish them to the students.

1. Click the check box to select the recording you want to publish.

2. Choose Publish from the More Actions menu. :
Publish details: Plant Life Under Water R |

3. In the Publish Details dialog box that appears,
navigate to the month in which you want to
publish the recording.

[¥l Publish
[JEnable auta Rublish [CJEnable auto Hide

< losptember 2006 > ] | lseptemberzoos ]

4, Click the day on which you want to publish.

5. Click OK.

Tip:  You can arrange to have a recording
published automatically on one date.
Then you can enable Auto Hide so that
the recording is no longer available to
students after a date you specify.
Remember: To select a date, you must
click its number in the calendar.

Ok

Subscribing to an iPod Podcast

The Tegrity course is available as a podcast. Subscribing to the podcast lets you and your students listen to your
classes on your iPod or in iTunes on your PC.

1. In your course management page, click the iPod button (near the bottom of the page).

2. In the dialog box that appears, click Subscribe.
Once you click Subscribe, iTunes launches and begins downloading the class recordings.
Refer to your iTunes and iPod documentation for additional information on using iTunes and synchronizing

podcasts to your iPod.

Important: You must have iTunes installed to subscribe to this podcast. You can download iTunes for free at
http://www.apple.com/itunes/download/PM
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Subscribing to an MP3 Podcast

The Tegrity course is available as a podcast. Subscribing to the podcast allows you to listen to your classes on
your digital music player and podcasting software.

1. In your course management page, click the MP3 button (near the bottom of the page).
2. In the dialog box that appears, click Copy to Clipboard.

3. Then paste the link into your podcasting application and click Close to dismiss the subscription dialog box.

Refer to your digital music player and podcasting software documentation for additional information about
listening to podcasts and synchronizing them to your digital music player.

Subscribing to an RSS Feed

The Tegrity course includes an RSS feed. To receive notification when new classes are available (uploaded and
published), subscribe to the RSS feed for this course.

1. In your course management page, click the RSS button (near the bottom of the page).
2. In the dialog box that appears, select the URL provided and copy it to your RSS reader.

3. Then click Close to dismiss the subscription dialog box.

Note: Refer to your RSS aggregator application documentation for additional information on subscribing to
and reading RSS feeds.

Navigating from Page to Page

The course management page lists all your uploaded class recordings. As the recordings accumulate, you fill up
one page and add another. To move from page to page, use the navigation tools at the bottom of the screen:

m  fthere is only one page, the summary information is
provided, Page 1 of 1 and the total number of class Page 1 of 1 pages (6 recordings)

recordings, chapters, or courses on the page.

m  Ifyou are on the first page of a multi-page list, you
can select a specific page by clicking its number, or | Page 1 2 3 4 of 5 pages (46 recordings)

you can simply click the Next Page arrow.

m  Ifyou are on an interior page of a multi-page list, ——Next Page button
you can select a specific page by number or click

either the Next Page or Previous Page arrow

- - Pagez 5 4 5 of 9 pages (46 recordings)

L Previous Page button
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Including Video in the Recording

Including Video in the Recording

If you have a video camera connected to your PC, Tegrity Campus recognizes it and incorporates it into the
Tegrity Recorder dialog box.

Note: The first time you connect a video camera and launch Tegrity Recorder, the check box for Instructor
Video is inactive (no check mark). After that, with the camera connected, Instructor Video is active as
soon as you launch Tegrity Recorder.

T Tegrity Recorder

Hello, Second Instructor idick to change)

Course: |Microhialogy ~]

The test button says
Test Video
(instead of Test Audio).

Recording Title: [Tus.Oct03, 10 42 AM

]
{ Select Ficture | Test'\f’ideo || Settings | | Tutarial
I |
I

Record a Class i TEGRITY

With your video camera turned on
and plugged into your PC, you can
see the video image here. __|

Recommended

Audio Level

The Instructor Video check box
appears, with a check mark.——w Instructor Video
(The first time you use the video
feature, the check box is blank.)
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Including Video in the Recording

Testing the Video Quality

This procedure is for someone who has detailed knowledge of the video camera that is being tested.

1. To launch the test, click Test Video. ]

2. In the dialog box that appears, click Start
Test. . . - | Sefings |
Start Test
. Cluse“:
As the test proceeds, you can choose to stop it at any time by clicking Stop Test.
otop Test
After you click Stop Test, you may continue testing (Start Test) or review the test
Flay Test
The video playback appears in a small window.
To close the player window, T Tegrity Recorder h_q

click the close box (the red X). \ v gl
>

While the video plays, you can use the
control panel to pause/play or stop it. And
you can raise or lower the player volume.
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Chapter 2: Using the Tegrity Instructor Pen

The pen software is in your pen case. See page 38 for installation instructions.

With the Tegrity Pen Reader attached to plain paper, and using the Tegrity Instructor Pen, you are free to
create diagrams, map relationships, write examples—anything you might write on a classroom
whiteboard or on transparencies for an overhead projector. The Tegrity Instructor Pen is a valuable tool
for noting and responding to impromptu comments and questions from your students.

In This Chapter:

» Installing Batteries in the Tegrity Pen Reader

» Installing Batteries in the Tegrity Instructor Pen

» Replacing the Ink Cartridge in the Tegrity Instructor Pen
> Preparations for Recording

» Using the Tegrity Instructor Pen During Class

Installing Batteries in the Tegrity Pen Reader

1. Turn over the Pen Reader and
remove the battery compartment
cover.

2. Install two AAA batteries with the
poles positioned as shown on the
label that is embossed inside the
compartment.

3. Replace the battery compartment cover.
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Chapter 2: Using the Tegrity Instructor Pen

Installing Batteries in the Tegrity Instructor Pen

1. Remove the battery compartment r.
emove the battery compartment cove .:+}: | saterycoe
2. Install three SR41 batteries with the positive poles facingup. (- /"= Three SR4M
= : batteries

3. Replace the battery compartment cover.

Note: The lifetime of the three SR41 batteries supplied with
the Tegrity Pen may vary and cannot be guaranteed.

Replacing the Ink Cartridge in the Tegrity Instructor Pen

The end of the Pen cap also serves as an ink cartridge extractor. To install the refill, follow these steps.
1. Remove the Pen cap. Refill extractor in

Pen cap
2. Insert the tip of the pen straight down into the Pen cap extractor

and press gently so the extractor grabs the used ink cartridge.

3. Pull out the cartridge (attached to the extractor on the cap).

4. Slide a new ink cartridge into the tip of the Tegrity Pen and
press gently to secure it in place.

Warning: Do not attempt to open the Tegrity Pen. This
causes the pen to malfunction. /
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Chapter 2: Using the Tegrity Instructor Pen

Preparations for Recording

1. Clip the Tegrity Pen Reader to the top center of your paper—in portrait orientation.

The paper must be U.S. Letter size (8.5 x 11 inches). Be sure to slide the top of the paper all the way
into the clip on the Tegrity Pen Reader.

2. Connect the USB cable from the Tegrity Pen Reader to a USB port on your PC.

The plug that goes into the Pen Reader has a small embossed triangle (an arrow) on one side. That side
should face up when plugged into the Pen Reader.

Arrow up
Note: Once you begin recording, the
“Connected” message is replaced by
another, as explained in the section
“Using the Tegrity Instructor Pen During
Class” on page 32.

Important: For details about beginning the recording process, selecting a course, checking the
microphone, and so on, see “Capturing Your Class With Tegrity Recorder,” beginning on
page 1.
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Using the Tegrity Instructor Pen During Class

If you have clipped the Tegrity Pen Reader to the top of your paper and connected the USB cable from
the Pen Reader to a USB port on your PC, you are ready to begin. Conduct your class as usual and use
the pen whenever you would stop to write on a whiteboard. (For details on setting up the Pen Reader and
connecting the USB cable, see the section, “Preparations for Recordi?é;’;it??cgﬁge 31.)

1. With the Tegrity Pen Reader connected to your PC,
launch Tegrity Campus 2.0 and click the Record a
Class button.

€ )C B>y, M 11:12 aM

) Your Institution
The Tegrity Recorder dialog box appears. b 1 RN A

Record a Class

2. Verify the instructor name and the course title, and
type a title for the class recording.

If the name that appears is not yours,

click the name to change it. TRe i

Make sure the course selected from the |
drop-down list is correct for Hello, Second Instructor (click to change)
this class session. 1
Course: ] Microbiology Il _vj
Type a title you prefer. :
(If you want, you can include the Recording Title: ||Ff'fJU| 14,1027 AM
date/time information provided
or delete it.)
Select Picture TestAudio || Setings | | Tutorial
| Recommended
Audio Level
Record a Class button
—— Record a Class i TEGRITY

3. In the Tegrity Recorder dialog box, click the Record a Class button.
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During recording, the Tegrity Pen is activated whenever you turn on the pencil or insert
page icons from the annotation toolbar (see page 5 for details on annotations toolbar).
You do not have to press any of the buttons on the pen reader.

When you click the pencil icon, you can annotate over

anything that is currently on screen: the desktop,

applications and so forth. D II L l |ﬁ

When you click the insert page icon, you annotate on
whichever page you choose.

Important: The blank page on your computer screen is represented at full length, in
portrait mode, by default. That is, the size of the paper is scaled to fit into the space on
your screen. One advantage of this orientation is that you can write or draw on almost the
entire space of a sheet of paper.

< To ensure your successful use of the pen, keep these rules in mind:

Clip the Pen Reader to the top center Before you release the clip, slide
of the paper, in portrait orientation. | the Pen Reader as far as it can go
> onto your paper.

Write within the capture area

indicated by the dotted line. Write or draw large enough for

_ 7 students to see and easily read
the projected image.

Do not place your arm or other objects
on the paper between the Pen Reader )\;,\(
and your writing hand. Sensors in the
Pen Reader require an unobstructed
view of the Tegrity Pen. For added stability, clip the Pen
Reader to as many pages as fit
comfortably.

Keep the Pen Reader and paper
on a level surface.

Closing the annotations by clicking the “X” in
the grey toolbar above the main annotations S?c: — ‘ C;) E} X
toolbar de-activates the pen. | — A
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Chapter 3: Troubleshooting

If you encounter problems while using Tegrity Campus 2.0 and the Tegrity Instructor Pen, this chapter offers
some assistance. Look here for answers to your questions or to learn how to contact experts who can provide

remedies.

Important: Your first line of support should be your department’s or your institution’s IT department.

In This Chapter:

» Benefitting From the Online Tegrity Community

» Symptoms and Possible Solutions

Benefitting From the Online Tegrity Community

The Tegrity Community (http://community.tegrity.com) offers many resources. For example, you can find
product documentation, access to technical support information, and interactive Web-based training and
certification services.
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Chapter 4: Troubleshooting

Symptoms and Possible Solutions

In the recording window, there is no input from the microphone

<> Check your microphone.

If you are using an amplified or a wireless microphone, make sure it is turned on and not in the off or
standby position.

If you are using a wireless microphone make sure of the following:

The wireless receiver is turned on.

The volume on the microphone is not all the way down.

The volume on the receiver is not all the way down.

The receiver and the microphone are using the same frequency.

The audio cable from the computer is securely connected to the receiver.

<> Confirm that the audio cable is securely connected to the microphone port on the computer.

<> Confirm that all of the Sound and Audio Device Properties are properly configured.

36 e

a.

Select Start > Control Panel > Sounds and Audio Devices.
The Sound and Audio Devices window opens.

Click the Audio tab and make sure that the default device for sound recording is your
sound card.

Click the Voice tab and make sure that the default device for voice recording is your sound
card.

Click the Volume tab. In the device volume frame, click the Advanced button.
The Volume Settings window opens.
Click Options > Properties.

Choose the Recording radio button and make sure that the microphone is checked in the
list of devices.

. Click OK.

In Volume Settings, make sure that microphone is selected and the volume is not all the
way down.

Click Options > Advanced Controls.
If an advance button appears below the microphone volume settings click it.

Check the +20db check box and click ok.
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Chapter 4: Troubleshooting

My recordings won’t upload properly.

These are some possible causes of the problem:

e Make sure you are looking in the right place for the recording. That is, be sure you uploaded the class
recording to the course it belongs to.

e Ifyou get a zip file error, the server does not have enough disk space to store the recording.

Check with an IT expert at your institution and/or with the Tegrity Help Desk at your institution.

| am using the Tegrity Instructor Pen, and my writing is not
appearing.
It may be that you have the batteries inserted in the pen in the wrong direction (polarity) or that the batteries

are not functioning any longer. Also be sure your hand or another object is not blocking the pen reader’s
view of the writing area.

Please review the Instructor Guide sections, “Installing Batteries in the Tegrity Instructor Pen” on page 30
and “Using the Tegrity Instructor Pen During Class” on page 32.

My screen recordings are unfocused and blurry upon playback.

If you double-click the content window, the window expands to full screen. This usually fixes the problem.
If the problem persists, the cause may be recording a video from the desktop or from a Flash image. These
sources may play back as blurred and unfocused.

In the Tegrity Recorder window, someone else’s nhame appears
after “Hello.”
Click the name that appears after “Hello.” In the dialog box that appears, enter your course management

system (CMS) login name. If you do not know your CMS login name, or the name you were assigned is
rejected, contact your IT department.

My PowerPoint animations aren’t showing up in the recording.

Tegrity software captures Entrance-type PowerPoint animations. If you are using PowerPoint animations of
a different type, the recorded session cannot capture them. Please use PowerPoint Entrance animations or
slide transitions.

For additional information, see the Tip near the bottom of page 4.
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PEGRITY  Tegrity Installation Instructions — VERSION 2.0

1. Install your web camera with the disc provided, or the drivers can be
downloaded free from www.logitech.com. Microphone headset users usually
don’t need to install software to be able to record audio.

2. Install Tegrity Instructor Recording software via the web

a. Go to one of your Blackboard courses that has Tegrity Recordings uploaded
and click on the “Tegrity” link from the left-hand navigation (hold “Ctrl” to
bypass pop up blocker). (You must have uploaded at least one session for
the Blackboard Tegrity page to appear.)

b. From the Tegrity Viewer page that opens, click “Record a Class” button on
the top left.

c. The software will install and the recorder will begin. Click the red “X” to
close the window if you don’t wish to record a session at that time.

3. PEN USERS ONLY: Install Tegrity Notes (Pen). Install AFTER Tegrity 2.0
recording software is installed.

When prompted, enter user name, institution, and Serial Number: d5894b3a13
“Enter Text” screen: “Please enter Tegrity Server”: europa.yc.edu
“Setup Type” screen 1: check “Yes, Tegrity Instructor Pen”
During installation, you will get this prompt: “Tegrity Pen device not found. Please
plug in device.” Plug the cord from the Tegrity reader to a USB port on your
computer, after which the installation will continue.
Usage Notes

o Ifyou get an error when viewing the Tegrity session, you may need to

reinstall the Windows Media Player to view the Tegrity sessions. This is
available free from the Microsoft website.
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Contacts for Support

Tegrity contact at YC:

TELS
Thatcher Bohrman 928-776-2352

thatcher@yc.edu

SUPPORT HOTLINE:
877-741-6360

ONLINE information about Tegrity:

http://www?2.yc.edu/content/tels/resforfaculty/
tegrityatYC.htm

community.tegrity.com

www.teqgrity.com
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